196V3

www.philips.com/welcome

CS  Uzivatelska prirucka 1
Péce o zdkazniky a zdruka 28

Odstrariovani problému a
Casté dotazy 34

PHILIPS



Obsah

1.1
1.2
13

2.1
2.2
2.3

3.1
32

8.1
8.2
8.3

Dulezité 1
Bezpecnostni opatreni a Udrzba ... 1
VYSVELIENT ZAPISU wvvvervvvresivvrrsssenresssssesssssiessens 2
Likvidace produktu a obalového

materidlu... R 3
Sestaveni monitoru 4
Instalace........ w4
OVIAdANT MONITONU wovvirvivreessnveresssereesssniessesns 5

Odpojte stojanek podstavce a podstavec..”/

Optimalizace Obrazu .........ccceeeeveevceneenenne 9
SmartContrast. 9
Philips SmartControl Lite ... 9
Technické udaje 17
ReZimy rozliseni a predvoleb............. 20
Rizeni spotieby 21
Automatickd Uspora energie ... 21
Informace o regulaci.......cccoeceeeureenccncunces 22
Péce o zakazniky a zaruka..........coceuue.. 28
Postup pfi vadnych pixelech plochého

panelu spolecnosti Philips. ... 28
Péce o zdkazniky & zaruka........eencee 31

Odstranovani problém( a ¢asté dotazy 34
Odstrariovani problémd.....
SmartControl Lite - ¢asté dotazy ..
Obecné Casté dotazy ... 38




1. Dllezité

Tato elektronickd uzivatelskd prfrucka je urcena
pro kazdého uZivatele tohoto monitoru Philips.
Pred pouzivdnim monitoru si prectéte tuto
uzivatelskou prirucku. Obsahuje dllezité informace
a poznamky k pouzivani vaseho monitoru.

Zaruka Philips je platnd, pokud je vyrobek pouzivan
pro navrzenou potrebu v souladu s ndvodem a

po prilozenf origindlu faktury nebo pokladnim
dokladem, oznacujicim datum ndkupu, jméno
prodejce a modelové a vyrobnf &islo vyrobku.

1.1 Bezpecnostni opatreni a udrzba

) Varovani

Pouziti kontrol, Uprav nebo postupt jinym
zpUsobem nez je stanoveno v této dokumentaci
muze vést k ohroZenf Sokem, elektrickym a/nebo
mechanickym riziklm.

Prectéte si a dodrzujte tyto instrukce pri
zapojovéni a pouzivani vaseho PC monitoru:

Pouzivani

*  Chrarite monitor pred primym sluncem, velmi
silnymi sv&tly a jinymi zdroji tepla. Dlouhodobé
vystaven( takovémuto pdsobeni mize vést ke
ztrdté barev a poskozeni monitoru.

*  Odstrante veskeré predméty, které by mohly
spadnout do vétracich otvord nebo zabranit
dostate¢nému chlazen( elektroniky monitoru.

*  Nezakryvejte vétraci otvory ve skffice.

¢ Umistéte monitor na takové misto, ze kterého
bude elektrickd zdstr¢ka a zdsuvka snadno
pristupna.

* Jestlize jste vypnuli monitor odpojenim
napdjectho kabelu nebo kabelu napdjeciho
adaptéru, pred pripojenim kabelu pockejte 6
sekund, aby monitor fungoval normainé.

* Vzdy pouzivejte napdjeci kabel schvédleny
spolecnostf Philips. Pokud napdjeci kabel chybi,
obrat'te se na nejblizsi servisni stredisko. (Viz
informace o strediscich zdkaznické péce)

*  Béhem pouzivani nevystavujte monitor
nadmérnym otresim nebo ndrazdim.

*  Pfi pouzivani nebo pfemistovdni do monitoru
nekopejte a zabrarite pripadnému padu.

Udrzba

*  Aby byl tento monitor chrdnén pred moznym
poskozenim, nevyvijejte nadmérny tlak na panel
monitoru. Pfi pfemistovani zvedejte monitor
za ram; pri zvedani monitoru nesahejte rukou
nebo prsty na panel monitoru.

* Nebudete-li monitor delsi dobu pouzivat,
odpojte jej ze z4suvky.

* Pred ocisténim mirné navihéenym hadrikem
monitor odpojte ze zdsuvky. Je-li vypnuté
napdjent, Ize obrazovku otrit suchym hadrikem.
K ¢isténi monitoru nikdy nepouzivejte
organickd rozpoustédla, jako napriklad alkohol
nebo distie s obsahem ¢pavku.

» Zabrarite nebezpedf drazu elektrickym
proudem nebo trvalého poskozeni monitoru
a chrarite monitor pred prachem, destém,
vodou nebo nadmérné vihkym prostredim.

*  Pokud dojde k namoceni monitoru, co nejdrive

jej osuste suchym hadrikem.

*  Vnikne-li do monitoru cizf ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrarite cizf latku nebo vodu z
monitoru a odeslete jej do servisniho strediska.

*  Monitor neskladujte ani nepouzivejte
na mistech vystavenych teplu, pifmému
slune¢nimu zdf'enf nebo extrémnim teplotdm.

*  Chcete-li zachovat optimalni vykonnost
monitoru a prodlouzit jeho Zivotnost,
pouzivejte jej na misté, které spliiuje ndsledujicl
rozsahy teplot a vihkosti.

o Teplota: 0-40°C 32-95°F
o Vlhkost: 20-80% relativni vinkosti



Dulezité informace o vypaleném obrazu &i
»duchu®

* Pred ponechdnim monitoru bez dozoru vzdy
aktivujte sporic¢ obrazovky. Bude-li na vasem
monitoru zobrazen neménici se staticky obsah,
vzdy aktivujte aplikaci pro pravidelnou obnovu
obrazovky. Dlouhodobé neprerusované
zobrazeni nehybného nebo statického obrazu
mdze zpusobit ,,vypdleni™ obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,,zobrazenf duchd".

* L Vypélen(, ,dosvit" nebo ,zobrazeni duchd*
je dobre zndmy jev u technologie panell
monitoru.V mnoha pripadech ,vypaleni*,

,, dosvit" nebo ,zobrazeni duchd" postupné
zmizf po urcité dobé mimo provoz.

() Vystraha
Pokud neaktivujete spori¢ obrazovky nebo aplikaci

pro pravidelné obnoven( obrazovky, mdze to vést
k zavaznym symptomudm ,,vypaleného obrazu*,
,paobrazu” nebo ,,duchu’, které nezmizf ani je
nelze opravit. Na vyse uvedené poskozen( se
nevztahuje zdruka.

Servis

*  Kryt pldsté mdze otevift pouze kvalifikovany
servisni pracovnik.

*  Pokud je pro opravu vyzadovdna dokumentace
nebo integrace, obrat'te se na nejblizsi servisnf
stredisko. (Viz kapitola ,,Stredisko zakaznické
péce")

* Informace o preevézeni najdete v Césti
,, Technické Udaje™.

* Neponechdvejte monitor v auté nebo
v zavazadlovém prostoru auta na primém
slunci.

€& Pozniamka

Pokud monitor nefunguje spravné nebo pokud
si nejste jisti, jaké kroky je treba provést po
provedeni pokynU v této prirucce, obratte se na
servisniho pracovnika.

1.2 Vysvétleni zapisu

Nasledujici pododdily popisuji zplsob zépisu, ktery
se pouzivad v této prirucce.

Pozndmky, upozornéni a vystrahy

Na strankdch této prirucky mizete narazit na text,
ktery je opatreny symbolem a je vytistén tu¢né
nebo kurzivou. Takové Useky obsahuji pozndmky,
upozornéni a vystrahy. Jejich pouzitf je ndsledujici:

© Poznimka

Tento symbol oznacuje dllezité informace a
navrhy, které pomahaji [épe vyuzit pocitacovy
systém.

@ Upozornéni

Tento symbol oznacuje informace, které objasriujf,
jak se vyhnout moznému poskozenf zafizeni nebo
ztraté dat.

) Vystraha

Tento symbol oznacuje nebezped( télesného
ubliZzenf a vysvétluje, jak se danému problému
vyhnout.

Neékteré vystrahy se mohou objevit v riizné
podobé a nemusi byt uvozeny symbolem.V
takovém pripadé je konkrétnf vyznaceni vystrahy
narizeno Uradem pro regulaci.



1.3 Likvidace produktu a obalového materialu

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its packaging
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic
appliances, this product may not be disposed

of with normal household waste.You are
responsible for disposal of this equipment through
a designated waste electrical and electronic
equipment collection. To determine the locations
for dropping off such waste electrical and
electronic, contact your local government office,
the waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that can be
recycled and reused. Specialized companies can
recycle your product to increase the amount of
reusable materials and to minimize the amount to
be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on how
to dispose of your old monitor and packing from
your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be recycled
and reused.

To learn more about our recycling program please
visit wwwi.philips.com/about/sustainability/recycling.




E1 Namontuijte stojanek podstavce

2. Sestaveni monitoru
1. Umistéte monitor obrazovkou dold na mékky

a hladky podklad, aby nedoslo k poskrabanf

2.1 Instalace obrazovky.
) 2. Pripojte sloupek zdkladny s monitorem, az
El Obsah krabice zaklapne do své polohy.

QS’Eart

PHILIPS

3. Uchopte monitor obéma rukama a pripevnéte
stojdnek podstavce do sloupku podstavce.

VGA (optional) DVI (optional)




El Pripojeni k poditaci

PHILIPS

il

|
W\W

O Zimek proti krddezi Kensington

Vstup napdjen(
Vstup VGA
Vstup DVI-D

Pripojeni k pocitaci

-

Pevné pripojte napdjeci kabel k zadnf
strané monitoru.

Vypnéte pocita¢ a odpojte jeho napdjecl
kabel.

Pripojte signdlovy kabel monitoru do

video konektoru na zadnf strané pocitace.

Zapojte napdjeci kabel pocitace a
monitoru do nejblizsi zdsuvky.
Zapnéte pocitac a monitor: Jestlize se
na monitoru objevi obraz, instalace je
dokoncena.

2.2 Ovladani monitoru

El Popis vyrobku z Eelniho pohledu

nnnnnnn 00000

(5]
auTo / W (TN O/ < /oK [O)
I I / N\ |
(7] (6] O © o o
Slouzi k zapnuti a vypnuti napajen(
|
o © monitoru.
© | ©/0K |Slouzi ke vstupu do nabidky OSD.
Slouzi k ndvratu na predchozi
© < droveri OSD.
o O-  |Upravte Uroves jasu.
© | A V¥V |Sloui k nastaveni OSD.
O | [ |Zméte formét zobrazent.
@ | s | Automaticky upravte monitor:




E1 Popis zobrazeni funkci na obrazovce Nabidka OSD

Co je nabidka na obrazovce (OSD)? NiZe je uveden celkovy pohled na strukturu OSD.
Tento prehled mlzete vyuzit, budete-li chtit
Funkcf nabidky obrazovky (On-Screen Display, pozdéji prozkoumat rliznd nastavent.

OSD) jsou vybaveny viechny monitory Philips.
Umozriuje koncovému uzivateli upravovat
vlastnosti obrazovky nebo vybirat funkce
monitoru primo prostrednictvim zobrazeného
okna s pokyny. Nize je uveden priklad prfjemného

Main menu Sub menu

VGA
— Input [

DVI (available for selective models)

e . Picture Format — Wide Screen, 4:3
rozhrani obrazovky: | Picture
Brightness — 0~100
Contrast — 0~100
SmartContrast — On, Off
Color Temperature — 6500K, 9300K
[— Color
sRGB
User Define Red: 0~100
E Green: 0~100
Blue: 0~100
|— Language — English . Espafiol, Francais, Deutsch, Italiano,

Portugués, Pycckuii, fiij {1 3, Tiirkge

r— Horizontal — 0~100
|— OSD Settings
— Vertical — 0~100
. - . I — Transparency ~ — Off1,2,3,4
Zakladni a jednoduché pokyny k ovladacim
vr1 o L— OSD Time out — 55,105,205,305,60s
tlacitkdim
v z 7 7 SE[UP [ Aue
Ve vySe uvedené nabidce obrazovky OSD mohou | 1t Position o
uzivatelé pomocf tlacitek w A na prednim rdmu L v position o0
monitoru pohybovat kurzorem, OK potvrzovat | phase — 00
vybé&r nebo zménu. — Clock — 0-100
[ Resolution Notification — On, Off
— Reset — Yes, No
L Information




El Poznamka k rozliden 2.3 Odpojte stojanek podstavce a podstavec
Tento monitor je uréen pro optimdini vykon pri
nativnim rozlisen 1366 x 768 pri 60 Hz. Kdyz je
monitor zapnut pfi jiném rozlidenf, na obrazovce se  Nez zanete demontovat podstavec monitoru,
zobrazi vystraha: Pro dosaZeni nejlepsich vysledkd postupujte podle pokynd nize, aby se zabranilo
pouZifte rozligenf 1366 x 768 pii 60 Hz. poskozenf nebo zranéni.

Zobrazovani vystrahy na nativnf rozlisenf Ize
vypnout v ¢dsti Setup (Nastaven) v nabidce OSD.

El Demontéz stojanku podstavce

1. Umistéte monitor obrazovkou doll na mékky
podklad, aby nedoslo k poskrabdni obrazovky.

B Fyzické funkce

Ndéklon

2. Stisknéte jistici spony pro odpojenf stojanu
zékladny od sloupku zakladny.

3. Stisknéte uvolriovac( tlacitko pro odpojenf
sloupku zékladny.




E1 Demontdz podstavce

1. MlZete pouzit Sroubovak na Srouby s plochou
hlavou, ktery vsunete do dvou uvolriovacich
otvorl na krytu zdvésu, a jemné stouchnout do
krytu zavésu a odstranit jej.

2. Odmontujte 4 Srouby a potom sejméte podsta-
vec z monitoru.




3. Optimalizace Obrazu

3.1 SmartContrast
E Cojeto?

Jedinecna technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastnf pomé&r monitoru pro maximalnf vizudinf
Cistotu a pozitek ze sledovani. ZvySuje podsviceni
pro jasnéjsi, ostrejsi a jasné&jsi obraz nebo snizuje
podsvicen( pro jasné zobrazeni obrazu s tmavym
pozadim.

E1 Proé to potFebuii?

Zadéte nejvy¥f vizudlni gistotu a pohodli sledovani

jakéhokoli typu obsahu. SmartContrast dynamicky
ridi kontrast a upravuje podsvicenf pro jasné, ostré
a jasné zobrazen( her a videa nebo pro zobrazenf
jasného, citelného textu pro kanceldrskou prdci.
Omezenim spotreby monitoru Setrite néklady a
prodluzujete zivot vaseho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v rediném
Case analyzovat zobrazeny obsah a upravovat
barvy a ridit intenzitu podsvicenf. Tato funkce
bude dynamicky vylepSovat kontrast pro skvély
zézitek pii prohlizenf fotografif nebo hranf her.

3.2 Philips SmartControl Lite

Novy software SmartControl Lite od spole¢nosti
Phillips umoZzriuje ovlddat monitor prostrednictvim
snadno pouzitelného grafického rozhranf na
obrazovce. Slozitd nastaven( jsou minulostf, protoze
tento uzivatelsky prijemny software vds provede
jemnym vyladénim rozlisenf, kalibraci barey,
nastavenim frekvence/féze, nastavenim bilého bodu
RGB atd.

Tento software zalozeny na pritazlivych
animovanych ikondch kompatibilnf se systémem
Windows 7, ktery je vybaven nejnovéjsi technologif
v jadrovém algoritmu pro rychlé zpracovani a
odezvuy, je pripraven rozsifit vasi zkusenost s
monitory Philips!

El Instalace

* Postupujte podle pokynl a dokoncete instalaci.

*  Muizete spustit po dokoncenf instalace.

*  Chcete-li spustit pozdéji, mizete klepnout na
zdstupce na pracovni plose nebo na panel
nastrojd.

PHILIPS

www philips.com/welcome

Monitor driver and software installation




Prvni spusténi —Wizard (Privodce)

*  Pfi prvnim spusténi po instalaci prejde
SmartControl Lite automaticky na Wizard
(Pravodce).

» Tento privodce vés provede podrobnym
nastavenim vykonu monitoru.

*  Prlvodce mdZete rovné€Z spustit pozdéji z
nabidky Plug-in (Zasuvny modul).

*  Dalsi moznosti mlzete nastavit bez
pravodce prostrednictvim podokna Standard
(Standardni).

8 smartcontrol 2 Phips 22581 (CS30715000001) ()X

SmartControl Lite PHILIPS

Wizard

You'l need to calbrate your dsplay to get the most

Adjust

Audio
\g Auto Prot
-
Color

Input

e \I%d
L
Options

Presets

Muli Monkors

Start Weard

B3 Spusténi s podoknem Standard (Standardni):

Nabidka Adjust (Nastaveni):

* Nabidka Adjust (Nastaveni) umozriuje upravit
Brightness (Jas), kontrast (Kontrast), Focus
(Ohnisko), Position (Poloha) a Resolution
(Rozligen).

*  MulzZete postupovat podle pokynd a provést
nastavent.

* Cancel (Storno) vyziva uzivatele, chcete-li
ukonit instalaci.

B SmartControl 2-Phiips 22581 (C530715000001) (2)\X;

W smatcontol

SmartControl Lite

SmartControl Lite

il

PHILIPS

Brightness

wil result in a loss of
: the Brightness for

1. Lower the Brightness to the minmum level
2 Brightness to t

Adjust {
Brightness
Color -
A
. Focus rightnes: 0
& - *
onins §
“
et

Help

2 - Phiips 22581 (CS30715000001) {18} X.
PHILIPS

Contrast

Adjust the Contrast (use the sider) to keep detais in

. Raise the Contrast unt the numbers 1 and 2
are no longer visble.
Slow the Contrast to make the

nd 3 reappear. The number 1
emain barely visble

Adjust.
Brightness
\g Contrast
Color R
A
\ Focus Contrast 50
AN
$ - *
Postion
Optons P Undo Reset
e
Resolution

&

Help




8 SmartControl 2 - Philps 22581 (CS30715000001) [#)%)

SmartControl Lite PHILIPS

Focus

Your dispiay's timing needs to be synchronzed with
the video signal

1. Choose Auto Setu
1f the vrticl bands are st v, you'l need
to adjust the Pitch.
: Try to make the vertical bands dsappear.

flust to the brightest setting to minmize

]

s n the screen.
Brightness

\g i Pitch 50

Color = +

e Phase 7

Postion

Options &

Resolution

€

_ Undo _ AuoSewp

&

Help

B smartControl 2 - Philps 22581 (C530715000001) {Z3(X

SmartControl Lite PHILIPS

Position

Use the Position buttons to center the image on
Your disply. Using this tool, you can postion the image
up, down, left, or right.

- Use the Up/Down buttons to center the image

f
vertcaly
2. Use the Left/Rght buttons to center the image
horizontally.
Adjust
Brightness
\g Contrast
Color an
R
. Focus
T
\@ Poston
undo Reset

; Resolution

B8 SmartControl 2 - Philps 22581 (CS30715000001) {#}\X)

SmartControl Lite PHILIPS

Resolution

You are currently 3t 3 Preferred resolution. For your
display to show crsp, ciear text, colors, and mages,
Your display should be set to fs Preferred resolution.

I your display s at a Non-Preferred reslution, click
on the Preferred button to change your resolution to

]

Adiust y I Enable Resolution Notifer

Brightness Picture Format
I 43 aectato

i

Contrast
Color

B

Focus

€

preferied

Optons

B H“H‘mHHNH“HH“HHN

%
8
13
g

Nabidka Color (Barva):

* Nabidka Color (Barva) umoZzriuje upravit RGB,
Black Level (Uroveti ¢erné), White Point (Bily
bod), Color Calibration (Kalibrace barev) a
Smartimage Lite (viz ¢ast Smartlmage Lite).

*  Mdzete postupovat podle pokyn( a provést
nastavent.

* V ndsledujici tabulce vyhledejte polozku
podnabidky na zakladé vaseho vstupu.

* Priklad pro Color Calibration (Kalibrace barev)

B8 smartControl 2 - hiips 22581 (€530715000001) {F}(X)

SmartControl Lite

PHILIPS

Black Level
Improperly adjusted Black Level wil result i a loss of
detai n darker mage arezs. Adjust the Black Level for
the best possble picture qualty.
1. Adjust the black level of the Red, Graen, and
Blue using the sider bars

m

Adiust RGB
W -
Biack Level = +
Green 50
Color White Paint = &
— Bue 50
\g Display Gamma o &
Undo Reset
Optons Galbration
ap
Smartimage
Help
88 smartControl 2- Philps 22581 (C530715000001) (21X

SmartControl Lite

PHILIPS

White Point

White Point i the pont t which equal combinations
red, green, and blue light at full ntensty creats
white. This effects the overal color quaity. For the

most accurate colors cick the Reset button then

| cict the whte pont
| 1. Plase slect the Whe Pont vle o the best
lll possible color qualty.

Adiust RGB

Back Level

Color White Pont:

. g White Point 6500K
Display Gamma o &

|
g - unio st

Options Caibration
ap
Smartimage
Help



3. Optimalizace Obrazu

W smartcontrol

SmartControl Lite

@

Adiust RGB
Color Whe Pont
Display Gamma
-
Options Calbration
g ap
Smartimage
Help
8 SmartControl

SmartControl Lite

2-Phips 22581 (CS30715000001) \)(X)
PHILIPS

Display Gamma

(Gamma & a companent of the pixelbrightness n 2
diplay. A lower Gamma vabue produces brighter pixes
and s higher Gama vabe produces darker pixls, The
defauk value for Gomma s 2.2

To adjust Gamma, Smartimage must be set to Off.
Cick the Smartimage Off button before adjusting
Gamma.

1. Use the sider to select the desred Gamma,

Dispby Gamma 22

Smartimage Off

Undo Reset.

2 - Phips 22581 (CS30715000001) {Z]\X)
PHILIPS

Calibration

‘Your dispy needs to be propery calibrated in order
for t to produce the widest range of colors accurately
Calibration should alays take place as the st tuning
step in the process. Remember to recalbrate any time.
vou make indidual adjustments to image qualty or

Calibration Screen (Obrazovka kalibrace) prvni
barvy:

* Tlacftko Previous (Predchozi) je deaktivovano
az na obrazovku druhé barvy.

*  Tlacftko Next (Dalsi) slouzi k prechodu na
nasledujici cil (6 cild).

*  Tlacitko Konecny slouzi k prechodu na File >
Presets (Soubor > podokno Predvolby).

* Tlacitko Cancel (Storno) slouzi k ukoncenf
uZivatelského rozhranf a k ndvratu na stranku

whenever you move your diplay to a new location.

=

zdsuvnych modull plug-in.

1. Make al other necessary adjustments to image
[l oy e
Adiust RGB 2. Press Show Me to leam how to use the
alibration to0k.

ook
. Finaly, press Start to beg the calibration

o process.
Cesiosioal ¥ Enable color caibration
Color software designed in collaboration with Joseph
ey
Color Whie Pont Protected by U.S. Patent No. 6,686,953
g ey G
Options Calibration
- ap
o

Help
Show Me start

Quick View

1. Tlacitko ,,Show Me" (Predvést) spusti vyukovy
program pro kalibraci barev.

2. Start (Spustit) — zahdji sekvenci kalibrace barev
o 6. krocich.

3. QuickView (Rychlé zobrazeni) nacte zobrazenf
pred/po.

4. Chcete-li se vrétit na hlavni stranku Color
(Barva), klepnéte na tlacitko Cancel (Storno).

5. Enable color calibration (Povolit kalibraci
barev) — ve vychozi konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta, kalibraci
barev nelze provést a tlacitka rychlé zobrazenf
nejsou k dispozici.

6. Na kalibra¢nf obrazovce musf byt zobrazeny
informace o patentech.
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Options >Preferences (Moznosti >Predvolby) —
Tato moznost bude aktivni pouze po vybéru
polozky Preferences (Predvolby) v rozeviracf
nabidce Options (Moznosti). Na nepodporovaném
zobrazovacim zarizeni s podporou DDC/CI jsou k
dispozici pouze karty Help (Ndpovéda) a Options
(Moznosti).

W smartcontrol 2 Phips 22581 (CS30715000001) ()X
SmartControl Lite PHILIPS

Preferences

\g pralfences

Select language:

Engish 3

* Zobrazf nastaven( aktudinich predvoleb.

*  Zaskrtnuté tladitko aktivuje funkci. Zaskrtavaci
policko je prepinac.

* PoloZka Enable Context Menu (Povolit mistni
nabidku) na pracovni plose je ve vychozf
konfiguraci zaskrtnutd (Zapnuto). Po aktivaci
polozky Enable Context Menu (Povolit mistni
nabidku) se zobrazi vybéry SmartControl
Premium pro funkce Select Preset (Vybrat
predvolbu) a Tune Display (Ladéni zobrazen)
na pracovni plose klepnutim pravym tlacitkem
mysi na mistni nabidku. Volbou moznosti
Deaktivovdno bude polozka SmartControl
Premium odstranéna z mistni nabidky pravym
tlacitkem mysi.

* Polozka Enable Task Tray (Povolit ikonu na
hlavnim panelu) je ve vychozi konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Povolit mistni nabidku se zobraz( nabidka
SmartControl Lite na hlavnim panelu.
Klepnutim pravym tlacitkem my3i na ikonu
na hlavnim panelu se zobrazi moznosti

nabidky Help (Ndpovéda), Technical Support
(Odbornd pomoc), Check for Update
(Vyhledat aktualizace), About (O aplikaci) a
Exit (Konec). Kdyz je deaktivovana polozka
Enable task tray menu (Povolit nabidku na
hlavnim panelu), ikona na hlavnim panelu
zobrazuje pouze moznost EXIT (KONEC).

* Polozka Run at Startup (Spustit pfi startu) je
ve vychozi konfiguraci zaskrtnutd (Zapnuto).
Kdyz je tato polozka deaktivovana, funkce
SmartControl Lite se nespusti pfi startu
nebo nebude na hlavnim panelu. Funkci
SmartControl Lite Ize spustit pouze
prostrednictvim zdstupce na pracovni plose
nebo prostrednictvim souboru programu. Kdyz
toto policko neni zaskrtnuté (Deaktivovéno),
z4dnd predvolba nastavend pro spusténi pri
startu nebude nactena.

* Enable transparency mode (Aktivovat rezim
prahlednosti) (Windows 7,Vista, XP).Vychoz!
nastaven je 0 % neprdhlednost.

Options >Input (Moznosti >Vstup) — Tato
moznost bude aktivni pouze po vybéru polozky
Input (Vstup) v rozeviraci nabidce Options
(Moznosti). Na nepodporovaném zobrazovacim
zafizeni s podporou DDC/Cl jsou k dispozici
pouze karty Help (Ndpovéda) a Options
(Moznosti). Z&dné dali karty funkce SmartControl
Lite nejsou k dispozici.

8 smartControl 2 - Phips 22581 (€530715000001) {#)X

SmartControl Lite PHILIPS

Input

Adjust i 4

\ Auto Pivot.
Color Tnput

= b

g

2

Options resets

Help

Analog In Digial In
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*  Zobrazi podokno s pokyny Source (Zdroj) a

nastaven( aktudintho zdroje vstupu.
* U zobrazovacich zarizen( s jednim vstupem
nenf toto podokno zobrazeno.

Options >Audio (Moznosti >Zvuk) —Tato
moznost bude aktivni pouze po vybéru polozky
Audio (Hlasitost) v rozeviraci nabidce Options
(Moznosti).

Na nepodporovaném zobrazovacim zarizenf s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

8 smartControl 2 - Philips 22581 (€S30715000001) (2 X,

SmartControl Lite PHILIPS

Volume of the integrated loudspeakers by
e sider.

grated loudspeakers by checking the

I Mute

Adiust

=

Color

Audio
L]
Auto Pivot

Input

Weard

R ¥

U
Options Presets

o

Muki Monitors

e

- Volume 100
Hep o

Undo

Help > User Manual (Napovéda > Uzivatelska
prirucka) — Tato moZznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelska
prirucka) v rozeviraci nabidce Help (Napovéda).
Na nepodporovaném zobrazovacim zarizeni s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).
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8 SmartControl 2-Phips 22581 (CS30715000001) ()X

SmartControl Lite PHILIPS

User Manual

Adiust

User Manual

-
\ ®

Color a
. Dsply D
.
Options 8
Ny Verson
Help

User Manual Tech. Support

Help >Version (Napovéda >Verze) — Tato
moznost bude aktivni pouze po vybé&ru polozky
Version (Verze) v rozeviracf nabidce Help
(Ndpovéda). Na nepodporovaném zobrazovacim
zarizen( s podporou DDC/CI jsou k dispozici
pouze karty Help (Ndpovéda) a Options
(Moznosti).

W smartcontrol 2 phips 22581 (Cs30715000001) ()X

SmartControl Lite PHILIPS

Version

ontrol
0.00 EVALUATION dtune-pp-R2009-12-17.

101

DDC/CI Communication: Yes - ATI2 API
Copyright © 1993-2009 Portrait Displays, Inc.
Adjust

User Manual

h
(i ®

Coor °
. Dispay ID
22N
\g System 1D
Options.
ry Verson
Help



Context Sensitive menu (Mistni nabidka)
Context Sensitive Menu (Mistni nabidka) je ve
vychozi konfiguraci Aktivovana. Nabidka bude
zobrazena po zaskrtnutl polozky Enable Context
Menu (Povolit mistni nabidku) v ¢asti Options >
podokno Preferences (Moznosti > podokno
Predvolby).

g SmartControl
Select Preset L]
Tune Display

Context Menu (Mistni nabidka) obsahuje ctyri

polozky:

*  SmartControl Lite — po vybéru se zobrazf
obrazovka O aplikaci.

*  Select Preset (Vybrat predvolbu) — nabizf
hierarchickou nabidku ulozenych preedvoleb
pro okamzité pouzitl. Aktudlné vybrand
predvolba je oznacena zaskrtnutim. V
rozeviraci nabidce Ize rovnéz vybrat polozku
Predvolby vyrobce.

» Tune Display (Ladéni zobrazenf) — otevie
ovladaci panel SmartControl Lite.

*  Smartlmage Lite — zkontrolujte aktudlnf
nastaven( Standard (Standardni), Internet,
Game (Hra).

15

Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu lze zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl Lite
na hlavnim panelu. Klepnutim levym tlacitkem lze
spustit aplikaci.

Help

Technical Support
Check for Update
About

Exk

Hlavni panel obsahuje pét polozek:

* Help (Ndpovéda) — pristup k souboru s User
Manual (uzivatelskou priruckou): Otevie
soubor s User Manual (uzivatelskou priruckou)
v okné vychoziho prohlizece.

* Technical Support (Odborna pomoc) —
zobrazf strdnku odborné pomoci.

*  Check for Update (Vyhledat aktualizace) —
zobrazf Uvodn( strdnku PDI a porovnd verzi
uZzivatele s nejaktudlnéjsi dostupnou verzi.

* About (O aplikaci) — zobraz podrobné
referencni informace: verze produktu,
informace o vyddni a ndzev produktu.

*  Exit (Konec) — ukonéi SmartControl Lite



Chcete-li znovu spustit funkci SmartControl Lite,
vyberte polozku SmartControl Lite z nabidky
Program, poklepejte na ikonu na pracovnf plose
pocitace nebo restartujte pocitac.

PHILIPS

SmartControl

SmartControl
“Wersion 3.20
hane-standard-R2007-D1-04-1151-23
Copyright 1993-2007 Pertrait Displaye, Inc.
Patents Pending

Deaktivovana nabidka hlavniho panelu

Kdyz je hlavni panel deaktivovén ve sloZce
Preference (Predvolby), je k dispozici pouze ¢dst
EXIT (KONEC). Chcete-li funkci SmartControl
Lite zcela odstranit z hlavniho panelu, deaktivujte
polozku Run at Startup (Spustit pfi startu) v ¢asti
Options >Preferences (Moznosti >Predvolby).

16



4. Technické udaje

Typ panelu monitoru

TFT-LCD

Podsviceni

CCFL (196V3), LED (196V3L)

Velikost panelu

185" (47,0 cm)

Pomér stran

16:9

Rozte¢ obrazovych bodl

0,3x0,3 mm

Jas

200 cd/m? (196V3), 250 cdim? (196V3L)

SmartContrast

500.000:1 (196V3), 10.000.000:1 (196V3L)

Kontrastni pomér (typ.)

700:1 (196V3), 1.000:1 (196V3L)

Doba odezvy (typicka)

5 ms

Optimaln{ rozlisenf

1366 x 768 pri 60 Hz

Zormy uhel

90° (H) / 65° (V) pri C/R>10 (196V3),
170° (H) / 160° (V) pri C/R>10 (196V3L)

Barevnost displeje

16,7 M

Vertikdlni obnovovaci
frekvence

56 Hz — 76 Hz

Horizontdlni frekvence

30 kHz — 83 kHz

Usnadnénf pro uzivatele

sRGB ANO
Vstup signdlu DVI-D (digitdIn), VGA (analogovy)
Vstupnf signdl Oddélend synchronizace, synchronizace podle zelené

AO/Y /A 0 O /4 &/ok O

Jazyky nabidky OSD

anglictina, francouzstina, némcina, Spanélstina, italstina, rustina,

zjednodusena ¢instina, portugalstina, turectina

Dalsi usnadnénf

Z3amek Kensington

Kompatibilita s technologif
Plug & Play

Naklon -5/+20

DDC/CI, sRGB, Windows 7, Mac OSX; Linux
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Zapnuto

19,3W (typ), 20.8TW (max.)

Spotreba energie (Metoda
testovani EnergyStar 5.0)

Stridavé vstupnf
napéti pri 100 VAC

Strfdavé vstupnf
napéti pri 115 VAC

Stridavé vstupnf
napéti pri 230 VAC

+/-5 VAC, +/-5 VAC, +/-5 VAC,

50 Hz +/-5 Hz 50 Hz +/-5 Hz 50 Hz +/-5 Hz
Normalni provoz (typ.) 17,70 W 17,52 W 17,24 W
Spanek 05 W 05W 05 W
Vypnuto 05 W 05W 05 W

Rozptyl tepla*

Stridavé vstupnf
napéti pri 100 VAC
+/-5 VAC,

50 Hz +/-5 Hz

Strfdavé vstupnf
napéti pri 115 VAC
+/-5 VAC,

50 Hz +/-5 Hz

Stridavé vstupnf
napétf pri 230 VAC
+/-5 VAC,

50 Hz +/-5 Hz

Bé&zny provoz

60,41 BTU/hr

59,79 BTU/hr

58,82 BTU/hr

Spédnek 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr
Vypnuto 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr
Indikdtor napdjenf Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blikd)
Napdjenf Vypdleni, 100-240VAC, 50-60Hz

Zapnuto 17,6W (typ.), 19,0W (max.)

Spotreba energie (Metoda
testovani EnergyStar 5.0)

Stridavé vstupnf
napétf pri 100 VAC

Strfdavé vstupnf
napéti pri 115 VAC

Stridavé vstupnf
napétl pri 230 VAC

+/-5 VAC, +/-5 VAC, +/-5 VAC,

50 Hz +/-5 Hz 50 Hz +/-5 Hz 50 Hz +/-5 Hz
Normdlni provoz (typ.) 1415 W 14,10 W 14,10 W
Spanek 05 W 05 W 05 W
Vypnuto 05W 05 W 05W

Rozptyl tepla®

Stridavé vstupnf
napéti pri 100 VAC
+/-5 VAC,

50 Hz +/-5 Hz

Strfdavé vstupnf
napéti pri 115 VAC
+/-5 VAC,

50 Hz +/-5 Hz

Stridavé vstupnf
napéti pri 230 VAC
+/-5 VAC,

50 Hz +/-5 Hz

B&Zny provoz

48,29 BTU/hr

48,12 BTU/hr

48,12 BTU/hr

Spanek 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr
Vypnuto 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr
Indikdtor napdjenf Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blikd)
Napdjen( Vypdleni, 100-240VAC, 50-60Hz
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Vyrobek s podstavee (SxVxH)

463 x 358 x 204 mm

Vyrobek bez podstavce (5xVxH)

463 x 294 x 44 mm

Teplotni rozsah (provoz)

Vyrobek s podstavcem 2,58 kg
Vyrobek bez podstavce 2,42 kg
Vyrobek s obalem 321 kg

0°Caz 40 °C

Teplotni rozsah (mimo provoz)

-20°C az 60°C

Relativni vihkost

20% az 80%

Nadmorska vyska

Pouzirdnf: + 12 000 stop (3 658 m)

Mimo provoz: + 40 000 stop (12 192 m)

MTBF 30 000 hod.

ROHS ANO

EPEAT Certifikdt Silver. (www.epeat.net)
EnergyStar 5.0 (pouze u vybranych modeld)
Balen( 100% recyklovatelny

Specifické latky

Prohldseni o shodé

Barva

Kryt bez PVC BFR

Znacka CE, FCC trida B, GOAST, SEMKO, TCO Certified
(pouze u vybranych modeld), UL/cUL, BSMI, ISO9241-307,
Energy star 5.0

Cemd

Povrchova Uprava

Leskly/Textura

& Poznamka

N

. Certifikdt EPEAT Gold nebo Silver je platny pouze tam, kde spolec¢nost Philips zaregistruje produkt.

Informace o stavu registrace ve vasi zemi viz www.epeat.net.

N

www.philips.com/support.

Tyto Udaje se mohou zménit bez predchoziho ozndment. Stahnéte si nejnovéjsi verzi letdku z webu




4.1 Rezimy rozliseni a predvoleb

E Maximalni rozliseni

Pro 196V3/196V3L
1366 x 768 pri 60 Hz (analogovy vstup)
1366 x 768 pri 60 Hz (digitdIni vstup)

Bl Doporuéené rozliseni

Pro 196V3/196V3L
1366 x 768 pri 60 Hz (digitdIni vstup)

3147 720x400 70,09
3147 640x480 59,94
37,50 640x480 75,00
37,88 800x600 60,32
46,88 800x600 75,00
48,36 1024x768 60,00
60,02 1024x768 75,03
63,89 1280x1024 60,02
79,98 1280x1024 75,03
47,71 1366x768 59,79
e Poznamka

Upozomiujeme, Ze vas displej pracuje nejlépe pri
nativnim rozliseni 1366 x 768 pii 60 Hz. Chcete-

li dosdhnout nejlepsi zobrazenf, uplatnéte tuto

doporucenou hodnotu rozlisent.




5. Rizeni spotieby

5.1 Automaticka Uspora energie

Pokud je v daném pocitaci nainstalovdn software
nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdze automaticky
sniZit svou spotiebu energie, neni-li pouzivan.
Pokud pocfta¢ rozpoznad vstup z kldvesnice,

mysi nebo jiného vstupniho zarizenf, monitor se
automaticky ,,probudi*. Ndsledujicf tabulka uvadf
spotrebu energie a signalizaci této funkce pro

automatickou Usporu energie:

196V3

ReZim VESA | Video | H-synch. | V-synch. | Spotreba energie | Barva LED
Aktivni ZAP. Ano Ano <193 W (typ.) Bild
Spének VYP. Ne Ne <05 W (typ.) Bild

(pohotovost) (blika)

Vypnuto VYP. - - <05W (typ.) VYP.
196V3L

Rezim VESA | Video | H-synch. | V-synch. | Spotreba energie | Barva LED
Aktivni | ZAP. [ Ano Ao | <176 W (typ) B4
Spének VYP. Ne Ne <05W (typ.) Bila

(pohotovost) (blikd)

Vypnuto VYP. - - <05W (typ.) VYP.

Ndsledujic konfigurace se pouziva pri mérenf
energetické spotreby tohoto monitoru.

Nativni rozlisenf: 1366 x 768

Kontrast: 50%

Jas: 200 nitd (196V3), 250 nitd (196V3L)
Barevnd teplota: 6500 K s pIné bilym vzorkem

& Poznimka
Tyto Udaje se mohou zménit bez predchoziho
ozndment.



6. Informace o regulaci

Lead-free Product

Lead free display promotes
environmentally sound recovery and
disposal of waste from electrical and
electronic equipment. Toxic substances
like Lead has been eliminated and compliance with
European community’s stringent RoHs directive
mandating restrictions on hazardous substances

in electrical and electronic equipment have been
adhered to in order to make Philips monitors safe
to use throughout its life cycle.

Congratulations,
Your display is designed for both you and the

planet!

This ensures that your display

is designed, manufactured and

tested according to some of the strictest quality
and environmental requirements in the world.
This makes for a high performance product,
designed with the user in focus that also minimizes
the impact on the climate and our natural
environment.

The display you have just purchased
carries the TCO Certified label.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO Certified
represents one of the toughest certifications for
displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality is
tested to ensure top performance and reduce
sight and strain problems. Important parameters
are luminance, contrast, resolution, black level,
gamma curve, colour and luminance uniformity
and colour rendering

* Products are tested according to rigorous safety
standards at impartial laboratories

* Electric and magnetic fields emissions as low as
normal household background levels

* Low acoustic noise emissions (when applicable)

Some of the Environmental features of the TCO
Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS or
ISO 14001)

* Very low energy consumption both in on- and

standby mode minimize climate impact

Restrictions on chlorinated and brominated

flame retardants, plasticizers, plastics and heavy

metals such as cadmium, mercury and lead

(RoHS compliance)

* Both product and product packaging is prepared
for recycling

* The brand owner offers take-back options

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as well
as manufacturers all over the world. Since the end
of the 1980s TCO has been involved in influencing
the development of IT equipment in a more user-
friendly direction. Our labeling system started with
displays in 1992 and is now requested by users
and [Tmanufacturers all over the world. About
50% of all displays worldwide are TCO certified.

For more information, please visit
www.tcodevelopment.com

For displays with glossy bezels the user should
consider the placement of the display as the bezel
may cause disturbing reflections from surrounding
light and bright surfaces.
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EPEAT
(www.epeat.net)

“The EPEAT (Electronic Product
Environmental Assessment Tool)
program evaluates computer
desktops, laptops, and monitors
based on 51 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,
and provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.”

X
Q?

S

Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following
standards

EN60950-1:2006 (Safety requirement of
Information Technology Equipment)
EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)
EN55024:1998+A1:2001+A2:2003 (Immunity
requirement of Information Technology
Equipment)

EN61000-3-2:2006 (Limits for Harmonic
Current Emission)
EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker)
following provisions of directives applicable
2006/95/EC (Low Voltage Directive)
2004/108/EC (EMC Directive)
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2005/32/EC (EuP Directive, EC No. 1275/2008
mplementing Directive for Standby and Off
mode power consumption) and is produced
by a manufacturing organization on ISO9000
level.

The product also comply with the following
standards

1SO9241-307:2008 (Ergonomic requirement,
Analysis and compliance test methods for
electronic visual displays)

GS EK1-2000:2009 (GS mark requirement)
prEN50279:1998 (Low Frequency Electric and
Magnetic fields forVisual Display)

MPR-II (MPR:1990:8/1990:10 Low Frequency
Electric and Magnetic fields)

TCO certified (Requirement for

Environment Labeling of Ergonomics,

Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees) for
TCO versions

Energy Star Declaration
(www.energystar.gov)

ot

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR® guidelines
for energy efficiency.

& Note

We recommend you switch off the monitor when
it is not in use for a long time.



Federal Communications Commission (FCC)
Notice (U.S. Only)

© This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no
guarantee that interference will not occur

in a particular installation. If this equipment
does cause harmful interference to radio or
television reception, which can be determined
by turning the equipment off and on, the
user is encouraged to try to correct the
interference by one or more of the following
measures:

Reorient or relocate the receiving antenna.
Increase the separation between the
equipment and receiver.

Connect the equipment into an outlet on

a circuit different from that to which the
receiver is connected.

Consult the dealer or an experienced radio/
TV technician for help.

Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority to
operate the equipment.

Use only RF shielded cable that was supplied with
the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to rain
or excessive moisture.
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THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.



Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré

conforme auxlimites des appareils numériques
de class B,aux termes de l'article 15 Des
regles de la FCC. Ces limites sont concues

de fagon a fourir une protection raisonnable
contre les interférences nuisibles dans le cadre
d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréguences qui, si I'appareil n'est pas
installé et utilisé selon les consignes données,
peuvent causer des interférences nuisibles aux
communications radio.

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une installation
particuliere. Si cet appareil est la cause
d'interférences nuisibles pour la réception des
signaux de radio ou de télévision, ce qui peut

étre décelé en fermant I'équipement, puis en
le remettant en fonction, |'utilisateur pourrait

essayer de corriger la situation en prenant les

mesures suivantes:

* Réorienter ou déplacer I'antenne de réception.

* Augmenter la distance entre |'équipement et
le récepteur.

* Brancher I'équipement sur un autre circuit que

celui utilisé par le récepteur.
* Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour

les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

This dewvice belongs to catagory B devices as described in EM 55022, unless it is specrli-
cally stated that it is a Class A devics on the specification labal. The following applies to
devicas in Class A of EN 55022 (radius of profection up o 30 metars). The user of tha
devics is obliged to taks all staps necessery to remove sources of intarference to tals-
communication or other devicas.

Pakud neni na typovém &titku poditade uvedeno, Ze spadé do do fidy A podle EN 55022,
spadé automaticky do tidy B podie EN 55022, Pro zafizen zafazend do tfidy A (chranné
pésmo 30m) podie EN 55022 platl nésledujicl. Dojde-li k rudeni telekomunikatnich nebo
Pnych zafizeni je ufivatel povinmen provést takovd opatfgnl, aby rudeni odstranil.




Polish Center for Testing and Certification
Notice

The equipment should draw power from a socket
with an attached protection circuit (a three-
prong socket). All equipment that works together
(computer, monitor, printer, and so on) should
have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Pelskiego Centrum Badan i Certyfikacji

Pozostale instrukeje bezpieczensiwa
* Niena Ty s

af Kilka albwisd
ayt przediuz

North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR DU
STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)

| azearazogs |
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den
in der "Verordnung Uber den Schutz vor Schaden
durch Rontgenstrahlen" festgelegten Vorschriften.

Auf der Rickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften tber
die Bauart von Storstrahlern nach Anlage Ill @ 5
Abs. 4 der Rontgenverordnung erfiillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.

nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine bauartgleiche
eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dunklem
Untergrund zu verwenden (schlechte Lesbarkeit
und erhohte Augenbelastung bei zu geringem
Zeichenkontrast wéren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach
DIN 45 635 betrdgt 70dB (A) oder weniger.

[A)

ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products are produced and sold for
China market have to meet China RoHS request.

S EABLEROHS

REPEAN (ATFEEFRISREASENE) (HHRAPEKRMROHS)
BURERS B T A ST A S SN SR MRS ANERNEE

FREH L~
B (WHMRCRT)

HEEEYESTE
i HELGEYFRNTE
@ ES # Eatile EREE | SROEM
(PB) (Ha) | (Cd) (Cre+) (PEB) (PBDE)
b 0] (o] (o] o s] o]
CRTRRR X o] [e] o] [s] [e]
BRETREATE % [@] [@] [¢] [s] [e]
AR 4 x [s] [e] [e] ] [e]
RRIER R x [e] [e] [e] ] [e]
Rk /il x [e] [e] [e] ] (6]
. BT DRI R B - 1S B bR - SREN
O REEA BA BT RS BSE
(RF R RS A TEENFRORBERE) BEOREERL T
%+ Fonh ER B EE D R — SRR S Bl
{2 FEEFERTHEREORNRRTAL) SRHRRER LR ERH O Sk
HEMBRHSENER (BT HRHHS)

@ PR ORAL TR

SEFRRIRIIR CH4E) , P E R s
A A &8 E Y Ot R AL EH A )2
A RAAMI R, B AR S
A8 A2 A AR S AN PR R R T
ol NS« W7 de ™ FE A0 ST R

rREREFIERR
RIEREXR (RERNERATENE) FETERF
BERHIE(cd/W) | > 105

HERUZE LD 14
HERT GB 21520-2008

BUTEK:

FREXERAEARERENITIAR ¢ hitp//www.energylabel.gov.cn/

(EFRREFRELEBEREA) RTERSA

AT EEMRERFIPHIK, HHESTERRU MRS
IR, HESFERETT R BT e WA IR R KRR
M, BER fAélﬂtﬂﬁE%LATE’J@WLE-}SFEGFF?&W@
Lhg (SR

& Note

Above regulation certificate might only be applied
for selective models.
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7. Péce o zakazniky a zaruka

7.1 Postup pri vadnych pixelech plochého panelu
spole¢nosti Philips

Spole¢nost Philips se snazi doddvat vyrobky
vyrobnich postupl vyroby v tomto odvétvi a
prosazuje pifsnou kontrolu kvality. Defektlim pixell
nebo subpixell u panell monitoru TFT, které se
pouzivaji pro ploché monitory, se nicméné nékdy
nedd zabrénit. Zddny vyrobce nemUze zarucit, ze
Zddny panel nebude obsahovat vadné pixely, ale
spole¢nost Philips zarucuje, Zze kazdy monitor s
neprimérenym poctem defektd bude opraven
nebo vyménén

v rdmci zaruky. Tento text vysvétluje jednotlivé
druhy defektl na pixelech a urcuje dnosnou
droveri chybovosti pro kazdy druh. Aby bylo
mozné uplatnit zdrucni opravu nebo vymeénu,
musi pocet chybnych pixell panelu monitoru
TFT presdhnout tuto Uroven Unosnosti. Na
monitoru napriklad nesmf byt vice defektnich
dil¢ich obrazovych bodt nez 0,0004 %. Déle,
protoze nékteré typy kombinaci vad pixeld jsou
lépe postrehnutelné nez jiné, stanovuje pro né
spolecnost Philips jesté vétsi ndroky na kvalitu. Tato
norma se dodrzuje celosvétove.

subpixel subpixel subpixel

\ oy
il B

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se sklddd ze tif
subpixell v zdkladnich barvdch cervené, zelené a
modré. Kdyz je mnoho pixell pohromadeé, tvor{
obraz. Kdyz vechny subpixely uréitého pixelu
svitf, jevi se tyto tii subpixely spolecné jako jediny
bily pixel. Kdyz jsou vSechny tmavé, jevi se tyto tff

subpixely jako jeden cerny pixel. Dalsi kombinace
rozsvicenych a tmavych subpixeld se jevi jako
pixely riznych barev.

Druhy pixelovych vad

Vady pixell a subpixell se na obrazovce projevujf
rlznymi zpUsoby. Existuj dva druhy vad pixelu a v
ramci téchto druhd je nékolik typl subpixelovych
vad.

Kazy Jasnych Bodu

Defekty svétlych bodl se projevuji jako obrazové
body nebo dil¢i obrazové body, které vzdy svitf
nebo jsou ,aktivni’. Svétly bod je dil¢i obrazovy
bod, ktery vystupuje

z obrazovky, kdyz je na monitoru zobrazena tmava
plocha. Existuji ndsledujici typy defektd svétlych
bodu:

Jeden Cerveny, zeleny nebo modry subpixel

I C

Dva soundlezicl subpixely:

- Cerveny + modry = fialovy

- Cerveny + zeleny = Zluty

- zeleny + modry = svétle modry
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Tri soundlezicl rozsvicené subpixely (jeden bily
pixel)

& Poznamka
Cerveny nebo modry svétly bod musf byt o vice
nez 50 procent jasné€si, nez sousedni body; zeleny

svétly bod je o 30 procent jasnéjsi, nez sousednf
body.

Kazy Cernych Boda

Defekty tmavych bodud se projevuji jako obrazové
body nebo dil¢f obrazové body, které nikdy
nesviti nebo jsou ,neaktivni’. Tmavy bod je dil¢f
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena svétla plocha. Existujf
nasledujici typy defektd tmavych bodu:
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Vzdalenost pixelovych vad

ProtoZe vady pixell a subpixell stejného typu,
které se vyskytuji blizko sebe, mohou byt patrnéjs,
urcuje spolecnost Philips i tolerance na vzdélenost
vad pixeld.

Tolerance vad pixelQ

Aby bylo mozné uplatnit opravu nebo vyménu
kvlli vaddm pixeld v zaruéni dobé, musi panel
monitoru TFT v plochém monitoru Philips vady
pixell nebo subpixeld, které prekracuji tolerance
uvedené v ndsledujicich tabulkdch.




KAZY JASNYCH BODU PRIJATELNY POCET VAD

1 trvale svitici bod 3

2 sousedni trvale sviticl body 1

3 sousedni trvale svitici body (nebo 1 trvale svitici bily bod) 0
Vzddlenost mezi dvéma kazy jasnych bodi* >15 mm
Celkovy pocet kazl jasnych bodt viech typl 3

1 tmavy bod 5 nebo méné
2 sousedni tmavé body 2 nebo méné
3 sousedni tmavé body 0
Vzdalenost mezi dvéma kazy cernych bodi* >15 mm
Celkovy pocet kazli ¢ernych bodu viech typl 5 nebo méné

KAZY BODU CELKEM PRIJATELNY POCET VAD
Celkovy pocet kazl jasnych nebo cernych bodu viech typt 5 nebo méné
& Poznimka

1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod
Tento monitor je kompatibilnf se standardem 1SO9241-307.(1SO 9241-307: Ergonomie systémovych
interakef clovéka: Analyza a ovérovaci zkusebni metody pro elektronické zobrazovaci displeje)
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7.2 Péce o zakazniky & zaruka

Péce o zakazniky & zaruka

Podrobné informace o zdruce a pozadavku na dodate¢nou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz mizete kontaktovat mistni centrum péce o zdkazniky na nize

uvedenych telefonnich &islech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

Zemé ASC Cislo zakaznické péce Cena

Austria Siemens &S +43 0810 000206 €007
Belgium E Care +32 078 250851 € 0.06
Denmark A-novo +45 3525 8761 Local call tariff
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009
Germany Siemens &S +49 01803 386 853 €0.09

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Italy A-novo +39 840 320 041 €008
Luxembourg E Care +352 26 84 30 00 Local call tariff
Netherlands E Care +31 0900 0400 063 €0.10
Norway A-novo +47 2270 8250 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Sweden A-novo +46 08 632 0016 Local call tariff
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
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Kontaktni informace pro oblast STREDNI AVYCHODNI EVROPY:

:?;:L?snl?; Cislo zékaznické péce
Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Czech Rep. NA Asupport 800 100 697
Estonia NA FUJITSU +372 6519900
Hungary NA Serware . +36 12426331
NA Profi Service +36 1 814 8080
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
S— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
woros r‘f‘egm NA Kim Tec doo. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
Ut NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
Turkey NA Techpro +90 212 444 4 832

Kontaktni informace pro oblast LATINSKE AMERIKY:

Cislo zakaznické pé&e
0800 3330 856

Telefonni stredisko

Argentina Vermont

Brazil Vermont 0800-7254101

Kontaktni informace pro SEVERNI AMERIKU:

Zemé Telefonni stredisko ASC Cislo zakaznické péce
Canada Supercom Supercom (800) 479-6696
USA. TOS Teleplan (877) 835-1838

Kontaktni informace pro Cinu:

Cina
Cislo zékaznické péce: 4008 800 008
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Kontaktni informace pro oblast APMEA:

Telefonni

Cislo zakaznické péce

stredisko

Australia NA AGOS NETWORK PTY LTD 1300 360 386
Bancladesh NA Distributor: Computer Source 880-2-9141747,9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Distributor: Neat Technology Pte
Cambodia NA Ltd (Singapore) (warranty buy- | 855-023-999992
out)
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd. |\ -1\ Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 10 56677
‘ , ‘ ‘ , Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
Israel NA Eastronics LTD 1-800-567000
Malaysia NA g\;tjr Market Solutions (CE) Sdn 603 7953 3370
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
New Zealand | NA Visual Group Ltd. 0800 657447
Pakistan NA Philips Consumer Service (9221) 2737411-16
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
South Korea | NA PCS One Korea Ltd. 080-600-6600
Sri Lanka NA no d.IStI‘IbUtOF and/or service
provider currently
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
United Arab o AL SHAHD COMPUTER LL.C 00971 4 2276525
Emirates
. . +84 8 38248007 Ho Chi Minh City
Vietnam NA FPT Service Informatic Company | a4 5413 562666 Danang City

Ltd.

+84 5113.562666 Can tho Province
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. Odstranovani problému a
Casté dotazy

8.1 Odstranovani problému

Na této strdnce jsou uvedeny problémy, které
mUze odstranit uZivatel. Pokud problém pretrvava
i po vyzkouSen( téchto Fedeni, kontaktujte zdstupce
sluzeb pro zdkazniky spolecnosti Philips.

El B&iné problémy

Zadny obraz (indikator LED napajeni nesviti)

»  Zkontrolujte, zda je napdjeci kabel pripojen

k elektrické zdsuvce a do zadnf &3sti monitoru.
Nejdrive zkontrolujte, zda se vypinac na predni
stran& monitoru nachézi ve VYPNUTE poloze

a stiskn&te jej do ZAPNUTE polohy.

Zadny obraz (indikator LED napéjeni blika bile)

» Zkontrolujte, zda je zapnuty pocftac.
Zkontrolujte, zda je kabel signdlu radné
pripojen k pocitadi.

Zkontrolujte, zda nejsou ohnuté koliky na
pripojovaci strané kabelu monitoru. Pokud ano,
opravte nebo vymérite kabel.

Pravdépodobné je aktivovéna funkce rizenf
spotreby

Obrazovka rika

Attention

Check cable connection

Zkontrolujte, zda je kabel monitoru rddné
pripojen k pocitaci. (Rovnéz viz Pravodce
rychlym pouzivdnim).

Zkontrolujte, zda nejsou ohnuté koliky kabelu
monitoru.

Zkontrolujte, zda je zapnuty pocitac.
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Tlaéitko AUTO nefunguje

* Automaticka funkce je pouzitelnd pouze
v rezimu VGA-analogovy. Pokud vysledek
neni uspokojivy, mizete provést rucni dpravy
prostrednictvim nabidky OSD.

© Pozniamka
Automaticka funkce nenf pouzitelnd v rezimu DVI-
digitdIni, protoze je zbytecnd.

Viditelné znamky koure nebo jiskFeni

*  Neprovéddéjte zddné kroky pro odstrariovani
problém

Pro zajisténi bezpecnosti ihned odpojte
monitor od zdroje napdjenf

lhned kontaktujte zastupce sluzeb pro
zdkazniky spole¢nosti Philips.

Obraz neni vystredén

* Upravte polohu obrazu pomocfi funkce , Auto’
v hlavnich ovlddacich prvcich OSD.

Upravte polohu obrazu pomoci poloZek
Phase/Clock (Faze/frekvence) v ¢ésti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovladacf prvky OSD).Tato funkce je platnd
pouze v rezimu VGA.

Problémy se zobrazenim

Obraz se chvéje na obrazovce

»  Zkontrolujte, zda je kabel signdlu radné a
bezpelné pripojen ke grafické desce nebo k
pocftaci.

Dochazi ke svislému blikani

*  Upravte polohu obrazu pomoci funkce , Auto*
v hlavnich ovlddacich prvcich OSD.

Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v ¢ésti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD).Tato funkce je platnd

pouze v rezimu VGA.



Dochazi k vodorovnému blikani

Upravte polohu obrazu pomocf funkce , Auto*
v hlavnich ovladacich prvcich OSD.

Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v ¢ésti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD).Tato funkce je platnd
pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo prilis tmavy

* Upravte kontrast a jas na obrazovce OSD.

,Dosvit", ,,vypéleni* nebo “zobrazeni duchd*

zUstane po vypnuti napdjeni

* Dlouhodobé nepreruSované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit , vypaleni" obrazovky, rovnéz zndmé
jako ,,dosvit" nebo ,,zobrazenf duchd*.

., Vypélen, ,dosvit" nebo , zobrazeni duchd*

je dobre zndmy jev u technologie panell

monitoru.V mnoha pripadech ,,vypdleni*,

,,dosvit" nebo ,,zobrazeni duchd" postupné

zmizi po urcité dobé mimo provoz.

Pred ponechanim monitoru bez dozoru vzdy

aktivujte spori¢ obrazovky.

Bude-li na vaSem monitoru zobrazen neménicf

se staticky obsah, vzdy aktivujte aplikaci pro

pravidelnou obnovu obrazovky.

Vézné priznaky , vypéleni”,, dosvitu" nebo

,,zobrazeni duchd' nezmizf a nelze je opravit.

Na vySe uvedené poskozen( se nevztahuje

zdruka.
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Obraz je zdeformovany.Text je nejasny nebo

rozmazany

* Nastavte rozlidenf zobrazeni pocitace na stejny
rezim, v jakém se nachdzi doporucené nativni
rozlideni obrazovky monitoru.

Na obrazovce se objevuiji zelené, cervené, modré,

tmavé a bilé tecky

*  Zbyvajici body jsou normdéini vlastnostf
tekutych krystald pouzivanych soucasnou
technologifl. Dalsi podrobnosti viz pravidla pro
obrazové body.

Svétlo indikatoru ,,napajeni je prilis silné a rusi
MdZzete nastavit intenzitu svétla indikdtoru
,napdjeni* v ¢asti Power LED (Indikdtor LED
napdjeni) v ¢asti Setup (Nastaveni) v OSD
Main Controls (Hlavni ovlddaci prvky nabidky
OSsD).

Potrebujete-li dalsi pomoc, viz seznam Informacnf
strediska pro zdkazniky a kontaktujte zdstupce
sluzeb pro zdkazniky spolecnosti Philips.



8.2 SmartControl Lite - casté dotazy

OTAZKA 1:

Odpovéd:

OTAZKA 2:

Odpovéd:

Zménil jsem monitor v pocitaci za
jiny a technologie SmartControl
Lite se stala nepouzitelnou, co

am délat?
mam defat Odpovéd:

Restartujte pocitac a zjistéte, zda
technologie SmartControl Lite
funguje.V opacném pripadé bude
tfeba odebrat a znovu nainstalovat
SmartControl Lite, aby bylo
zajisténo, Ze je nainstalovan spravny
ovladac.

Technologie SmartControl Lite
drive dobre fungovala, ale nyni
nefunguje, co mam délat?

Pokud byly provedena ndsledujicf
kroky, bude pravdépodobné
nutné znovu nainstalovat ovladac
monitoru.

PouZijte jiny graficky adaptér videa
Zaktualizujte ovladac videa
Cinnosti na opera¢nim systému,
napriklad aktualizace nebo oprava
Spust'te sluzbu Aktualizace
Windows a zaktualizujte ovladac
monitoru a/nebo videa

Operacni systém Windows byl
zaveden, kdyz byl monitor vypnuty
nebo odpojeny.

Chcete-li ziskat dal3f informace,
klepnéte pravym tlacitkem

mysi na My Computer (Tento
pocitac) a klepnéte na Properties
(Vlastnosti) -> Hardware
(Hardware) -> Device Manager
(Sprévce zar{zen).

Pokud je pod polozkou Monitor
uvedeno ,,Plug and Play Monitor*
(Monitor Plug and Play), je treba
provést novou instalaci. Jednoduse
odeberte a znovu nainstalujte
SmartControl Lite.

Odpovéd:
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OTAZKA 3:

OTAZKA 4:

Kdyz po nainstalovani
SmartControl Lite klepnu na
kartu SmartControl Lite, ani po
chvili se nic nezobrazi nebo se
zobrazi zprava o chybg, co se
stalo?

V&3 graficky adaptér
pravdépodobné neni kompatibilnf
s technologif SmartControl Lite.
Pokud je vas graficky adaptér mezi
vySe uvedenymi znackami, zkuste
stahnout nejaktudlnéjsi ovladac
grafického adaptéru z webovych
stranek prislusného vyrobce.
Nainstalujte ovladac. Odeberte a
znovu nainstalujte SmartControl
Lite.

Pokud presto nefunguje,

graficky adaptér bohuzel nenf
podporovan. Na webovém serveru
spolecnosti Philips zjistéte, zda je
k dispozici zaktualizovany ovladac
SmartControl Lite.

Po klepnuti na Product
Information (Informace o
produktu) se zobrazi pouze
castecné informace, co se stalo?

Pravdépodobné nemdte k dispozici
nejaktualnéjsi verzi ovladace
adaptéru grafické karty, kterd plné
podporuje rozhrani DDC/CI.
Pokuste se stdhnout nejaktudingjsi
ovlada¢ grafického adaptéru

z webovych stranek prislusného
vyrobce. Nainstalujte ovladac.
Odeberte a znovu nainstalujte
SmartControl Lite.

Attention

Theft Deterence enabled




OTAZKA 5:

Odpovéd:

Zapomnél jsem svuj kod PIN pro
funkci zabezpeceni proti kradezi.
Co mam délat?

Servisnf stfedisko Philips md pravo
Zadat legitimn( identifikaci a ovérenf
pro zjistén( viastnictvi monitoru.

Upozormiujeme, ze jako prihodnd
volnd moznost je k dispozici funkce
pro zamezen( krddeze. Sprava Cisel
PIN je vyhradni odpoveédnostf
kazdého uZivatele nebo organizace,
kterd je nastavi.

Pokud ¢islo PIN zapomenete,
servisni centrum Philips vdm je
mUZze nastavit znovu za nominalnf
sazbu po ovérenf vlastnictvi.

Na tuto cinnost se nevztahujf
standardni zdru¢ni podminky.

37



8.3 Obecné casté dotazy

OTAZKA 1:

Odpovéd:

KdyzZ nainstaluji svij monitor, co
mam udélat, kdyZ se na obrazovce
zobrazi zprava ,,Cannot display
this video mode* (Tento rezim
videa nelze zobrazit)?

Doporucené rozliSenf pro tento
monitor: 1366 x 768 pri 60 Hz.
Odpojte vsechny kabely, potom
pripojte pocita¢ k monitoru, ktery
jste pouzili predtim.

V nabidce Start opera¢niho
systému Windows vyberte
Settings/Control Panel (Nastaveni/
Ovladaci panely).V okné Control
Panel (Ovlddaci panely) vyberte
ikonu Display (Zobrazeni).

Na panelu Display Control
(Zobrazen( — vlastnosti) vyberte
kartu ,,Settings” (Nastaveni). Na
karté nastaveni v poli oznaceném
,desktop area" (pracovni plocha)
presurite posuvnik na 1366 x 768
obrazovych bodu.

Klepnéte na ,,Advanced
Properties” (Upresnit), nastavte
polozku Refresh Rate (Obnovovacfi
frekvence) na 60 Hz a potom
klepnéte na OK.

Restartujte pocitac a zopakovanim
kroku 2 a 3 ovérte, zda je pocitac
nastaven na 1366 x 768 pri 60 Hz.
Vypnéte pocitac, odpojte stary
monitor a znovu pripojte monitor
Philips.

Zapnéte monitor a potom zapnéte
pocitac.
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OTAZKA 2:

Odpovéd:

OTAZKA 3:

Odpovéd:

OTAZKA 4:
Odpovéd:

Jaka je doporucena obnovovaci
frekvence monitoru?

Doporucend obnovovaci frekvence
u monitord je 60 Hz.V pripadé
jakéhokoli ruseni na obrazovce ji
mUZete nastavit na 75 Hz a uvidite,
zda ruseni zmizi.

Co jsou soubory .inf a .icm
na disku CD-ROM? Jak Ize
nainstalovat ovladace (.inf a .icm)?

Jednd se o soubory ovladace
monitoru. Pfi instalaci ovladacd
postupujte podle pokynu

v uZivatelské prirucce. Pfi

prvnf instalaci bude pocita¢
pravdépodobné pozadovat ovladace
monitoru (soubory .inf a .icm) nebo
disk s ovladadi. Postupujte podle
pokynt a viozte

( doprovodny disk CD-ROM), ktery
je souddsti této sady. Ovladace
monitoru (soubory .inf a .icm)
budou nainstalovdny automaticky.

Jak mam upravit rozliseni?

Dostupnd rozlisenf uréuje grafickd
karta/ovladac grafiky a monitor.
PoZadované rozliseni mizete vybrat
v ¢asti Control Panel (Ovlddacf
panely) systému Windows® v asti
,Display properties" (Zobrazenf -
vlastnosti).



OTAZKA 5:

Odpovéd:

OTAZKA 6:

Odpovéd:

OTAZKA 7:

Odpovéd:

OTAZKA 8:

Odpovéd:

Co kdyz se béhem nastaveni
monitoru ztratim prostfednictvim
nabidky OSD?

Jednoduse stisknéte tlacitko OK a
potom volbou ,,Reset” (Obnovit)
obnovte viechna plvodni nastavenf
vyrobce.

Je obrazovka monitoru odolna
proti poskrabani?

Obecné se doporucuje
nevystavovat povrch panelu
nadmeérnym dderlm a chrénit

jej pred ostrymi nebo tupymi
predméty. Pri manipulaci

s monitorem nevyvijejte na povrch
panelu zadny tlak ani sflu. Mohlo by
to negativné ovlivnit vade zarucnf
podminky.

Jak Ize cistit povrch monitoru?
Pro bézné cisténi pouzijte Cisty
a mékky hadrik. Pro ddkladné
cisténi pouzijte izopropyl
alkohol. NepouZivejte Zddnd jind
rozpoustédla, jako etylalkohol,
etanol, aceton, hexan atd.

Lze ménit nastaveni barev
monitoru?

Ano, nastaveni barev mizete
zménit prostrednictvim nabidky
OSD podle nésledujicich krokd:
Stisknutim tlacitka ,,OK" zobrazte
nabidku OSD.
Stisknutim tlacitka , Sipka dold*
vyberte volbu ,,Barva* a stisknutim
tlacitka ,,OK" preejdéte na nastavenf
barev. K dispozici jsou tri nastavenf
(viz nize).
1. Color Temperature (Teplota
barev): 2 nastaven( jsou 6500 K a
9300 K.

2. sRGB: standard pro zajisténf
spravné prenosu barev mezi
rlznymi zarfzenimi (napft. digitdlnf
fotoapardty, monitory, tiskarny,
skenery atd.)

3. User Define (UzZivatelské):
uzivatel si mdze zvolit viastnf
nastaveni barev upravenim
Cervené, zelené a modré slozky.

© Poznimka

Mereni svétla barvy, které vyzaruje predmét pri
zahrivani. Toto mérenf je vyjddreno v absolutnim
méritku (stupné Kelvina). Nizsi teploty Kelvina,
napriklad 2004 K jsou Cervené; vyssi teploty, jako
napfiklad 9300 K, jsou modré. NeutrdIni teplota je
bila pri 6504 K.

OTAZKA 9:  Lze pFipojit tento monitor k
libovolnému poéitaci, pracovni
stanici nebo pocitaci Mac?

Odpovéd: Ano.Vsechny monitory Philips jsou
pIn& kompatibiln{ se standardnimi
pocitadi, pocitaci Mac a pracovnimi
stanicemi. Pro pripojeni monitoru
k systému Mac muze byt zapotrebf
kabelovy adaptér. Dal3i informace

zdstupce Philips.

OTAZKA 10: Jsou monitory Philips vybaveny
technologii Plug-and-Play?

Odpovéd: Ano, tyto monitory jsou
kompatibilni s technologif
Plug-and-Play v operacnim systému
Windows 7,Vista, XP NT, Mac OSX
a Linux.
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OTAZKA 11:

Odpovéd:

() Vystraha

Co znamena Ipéni obrazu, vypéleni
obrazu, dosvit nebo ,,duch*
v souvislosti s panely monitoru?

Dlouhodobé neprerusované
zobrazeni nehybného nebo
statického obrazu mize zpUsobit
,vypaleni* obrazovky, rovnéz zndmé
jako ,,dosvit" nebo , zobrazenf
duchd". ,,\Vypélen*, ,dosvit" nebo
,zobrazeni duchd" je dobre zndmy
jev u technologie paneld monitoru.
V mnoha pripadech , vypalenf”,
,,dosvit'' nebo , zobrazeni duchd"
postupné zmizi po urcité dobé
mimo provoz.

Pred ponechdnim monitoru bez
dozoru vzdy aktivujte spori¢
obrazovky.

Bude-li na vasem monitoru
zobrazen neménici se staticky
obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky.

Vézné priznaky ,vypéleni,, dosvitu" nebo
,zobrazeni duchd" nezmizi a nelze je opravit. Na
vySe uvedené poskozen( se nevztahuje zdruka.

OTAZKA 12: Proc se na displeji nezobrazuje

Odpovéd:

ostry text a pro¢ maji zobrazené
znaky zubaté okraje?

V43 monitor nejlépe pracuje pri
svém nativnim rozliseni 1366 x
768 pri 60 Hz. Pouzivejte toto
rozliseni pro dosazeni optimaintho
zobrazen.
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